6/2/2017 Separate content process for file:// URLs [EngQA] - TestRail
S576: Separate content process for file:// URLs [EngQA]

1. Functional

C20002: Open a local file from the File menu

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2

2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

3. Have at least one local file saved on your PC (for e.g you can save the about: page)

Steps
Step Expected Result
1 Launch Firefox Firefox is properly opened
2 Open a new tab, go to File Menu, click on Open File -> select The Open File window is opened
any local file -> Open The selection of a local file is allowed
The local File is properly opened
3 Check the Task Manager A new local process is opened along with the local file from
the previous step
4 Close the local file opened in step 3 (check the task manager The local file along with its corresponding local process are

again) closed

https://testrail .stage.mozaws.net/index.php?/suites/plot/576&format=details 1/37



6/2/2017

Separate content process for file:// URLs [EngQA] - TestRail

C20003: Open a local file using the keyboard shortcut Ctrl+O/Cmd+0

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate
None

References
None

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

3. Have at least one local file saved on your PC (for e.g you can save the about: page)

Steps
Step

1 Launch Firefox

2 Open a new tab, hit the Ctrl+0 keys (CMD+0 on Mac OS X)
to open the Open File window

3 Select any local file and click on the Open button (look also at

the task manager/system monitor/Activity monitor)

4 Hover your mouse over the tab where the local file is opened
and look at the process number

5 Close the local file

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Expected Result

Firefox is properly opened

The Open File windows is properly opened

The local file is opened.
A new file content process is opened in the task
manager/system monitor/Activity monitor.

The process from the tab (should look like - "e10s XXXXX")
is the same with the local process that was opened in the
previous step in the task manager/system monitor/Activity
monitor.

The local file along with its corresponding local process are
closed
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C20004: Open a local file by drag and drop

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate
None

Separate content process for file:// URLs [EngQA] - TestRail

References
None

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

3. Have at least one local file saved on your PC (for e.g you can save the about: page)

Steps
Step

1 Launch Firefox

2 Drag a local file from your PC and drop it into the Firefox tabs
bar (look also at the task manager/system monitor/Activity
monitor)

3 Open a new Firefox window

4 Drag the tab with the local file from step 2 and drop it into
the new window from step 3 (look also at the task
manager/system monitor/Activity monitor)

5 In a new tab, open another local file (look also at the task
manager/system monitor/Activity monitor)

6 Drag the newly opened tab and drop it onto the Desktop
(look also at the task manager/system monitor/Activity
monitor)

7 In a new tab, open another local file of your choice

8 Close the local file from step 6 (look also at the task
manager/system monitor/Activity monitor)
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Expected Result

Firefox is opened

The local file is successfully opened in a new tab

A new file content process is opened in the task manager
(the PID number is the same in the task manager as is in the
tab with the opened local file )

A new window is opened

The drag and drop action is successfully done
The file content process remains the same

The local file is properly opened

A new file content process is opened in the task manager
(the PID number is the same in the task manager as is in the
tab with the opened local file )

A new window is opened (only one tab with the local file
opened)

The file content process remains the same as in the previous
step

The local file is properly opened
The file content process is the same with either the one from
step 2 or the one from step 6

The local file is properly closed

If the local file from step 7 has the same content process as
the local file from step 2, then the content process of the
local file from step 6 will be closed.

If the local file from step 7 has the same content process as
the local file from step 6, then no content process will be
closed
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C20005: Open a local file from an external application

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate

References

None None

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

3. Save several types of local files ( e.g: HTML, png, txt, pdf, WebM, etc)

4. Set Firefox as a default browser

Steps
Step
1 Launch Firefox
2 Open some local files from an external application (skype,

chat, document). Look also at the task manager/system
monitor/Activity monitor

3 Close all the local files one by one. (look also at the task
manager/system monitor/Activity monitor)
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Expected Result

Firefox is successfully opened

The local files are properly opened in new tabs

On Nightly - for the first 2 local files new content processes
will be opened. After that, the 2 opened processes will be
divided between all the opened local files randomly.

The 2 opened file content processes are properly closed.
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C20006: Open a local file in a new tab from a local file

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

a. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2

b. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

c. Create a local HTML name testl that contains a link to another local HTML. You can use this as an example ( don't forget to add the

path of the local file from point "b" here: <a href="local file path" target="_blank"> Click here </a>)
1st html file

<IDOCTYPE html>

<html>

<title>Testl </title>

<body>

<a href="data:xxxx" target="_blank"> Click here </a>
</body>

</html>

*Note: data:xxxx is the path of the local file
2st html file

<html xmlns="http://www.w3.0rg/1999/xhtml">

<head>

<title>Test2 < /title>

<link rel="stylesheet" href="chrome://global/skin/about.css" type="text/css"/>
</head>

<body dir="&locale.dir;">

<div id="aboutLogoContainer">
<aid="vendorURL">

<img src="about:logo" alt="&brandShortName;"/>
<p id="version">®&about.version; </p>

</a>

</div>

<ul id="aboutPageList">

<li>&about.credits.beforelLink; <a href="about:credits">&about.credits.linkTitle; </a>&about.credits.afterLink; </li>
<li>&about.license.beforeThelLink; <a href="about:license">&about.license.linkTitle; </a>&about.license.afterTheLink; </li>
<li hidden="true">&about.relnotes.beforeThelLink; <a id="releaseNotesURL">&about.relnotes.linkTitle;
</a>&about.relnotes.afterThelLink; </li>

<li>&about.buildconfig.beforeTheLink; <a href="about:buildconfig">&about.buildconfig.linkTitle; </a>&about.buildconfig.afterTheLink;

</li>
<li id="buildID">&about.buildIdentifier; </li>
<script type="application/javascript" src="chrome://global/content/about.js"/>

</ul>
</body>
</html>
Steps
Step Expected Result
1 Launch Firefox Firefox is opened
2 Open a new tab and load the 1st html local file (look also at 1st local HTML file is properly opened
the task manager/system monitor/Activity monitor) A new file content process is opened in the task manager
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(the PID number from task manager is the same as the
number that is displayed when hovering the mouse over the
containing tab)

3 Left click on the "Click here" link (look also at the task Open 2nd local HTML file is properly opened in a new tab
manager/system monitor/Activity monitor) Nightly - the local file is opened either using the same
content process as the one from step 2 either a new one. (2
content processes are allocated for the local files)

4 Go back to the local file from step 2 and middle click on the 2nd local HTML file is properly opened in a new tab
"Click here" link (look also at the task manager/system Nightly - the local file is opened either using the same
monitor/Activity monitor) content process as the one from step 2 either a new one. (2

content processes are allocated for the local files)
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C20007: Open a local file in a new window from a local file

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
2. Use local file Testl from the previous test case named "Open a local file in a new tab from a local file".
3. Open the Task manager (Windows)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the detailed processes

Steps
Step Expected Result
1 Launch Firefox Firefox is opened
2 Go to about:preferences -> General -> uncheck the "Open Preference is unchecked
new windows in a new tab instead" option
3 In a new tab open the Testl local file (check also the task 1st local html file is properly opened
manager/system monitor/Activity monitor) A new file content process is opened (the PID number from
task manager is the same as the number displayed when
hovering the mouse over the containing tab).
4 Click on the "Click here link" 1st local html file is opened in a new window.
The local file is opened either using the same content
process as the one from step 2 either a new one. (2 content
processes are allocated for the local files)
5 Close Test2 tab (check also the task manager/system The last opened window is properly closed

monitor/Activity monitor) If the content process ID was the same as in step 3, then no
content process will be closed BUT if a new content process
is opened in step 4, then that content process will be closed
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C20014: Open a local file with multiple iframes

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2

2. Create a local html file that contains the following code (name it Test3):
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.html" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.html" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.htmI" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.html" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.htm!" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.html" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.html" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.html" width=300 height=300> </iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.htm|" width=300 height=300></iframe>
<iframe src="https://people-mozilla.org/~dglastonbury/block-playback/autoplay-test-1.htm!" width=300 height=300> </iframe>

3. Open the Task manager (Windows)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the detailed processes

Steps
Step Expected Result
1 Launch Firefox Firefox is opened
2 In a new tab, open Test3 local file (check also the task Test3 local file is properly opened
manager/system monitor/Activity monitor) Only one new file content process is opened (the PID number
from task manager is the same as the number displayed
when hovering the mouse over the containing tab).
3 Close the Test3 tab The tab with the local file is properly closed

The file content process is also closed.
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C20015: Open a local file from a http page

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate References
None None

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

Steps
Step

1 Launch Firefox

2 Navigate to: https://jsbin.com/?html,output

3 Add this to <a href="data:xxxx" target="_blank">Click this

link </a> to the above jsbin page.
* data:xxxx - file path to one of yours local files

4 In a new tab navigate to:

https://addons.mozilla.org/en-US/firefox/addon/noscript/?

Src=ss
install the NoScript add-on and restart Firefox

Go to about:addons -> Extensions -> NoScript -> Options -
> Advanced -> Trusted -> Allow local links

Go back to the jsbin page, give permissions to the page by
selecting Allow All This Page on the Noscript Bar and click on

"Click this link" (check also the task manager/system
monitor/Activity monitor))

7 Close the local link tab

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Expected Result

Firefox is properly opened

Navigation is done

Click this link is displayed on the right side of the jsbin page

The NoScript add-on is installed

The local file added in step 2 is opened in a new tab

A new file content process is opened in the task manager
(the PID number from task manager is the same as the
number that is displayed when hovering the mouse over the
containing tab)

The local file is properly closed
The file content process opened in step 6 is closed
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C20016: Open local files in Private window

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate
None None

Separate content process for file:// URLs [EngQA] - TestRail

References

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

3. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps
Step
1 Launch Firefox
2 In the URL bar, click on Open menu -> New Private Window

3 In a new tab - open a local file of your choice (PNG, HTML,
WebM, .txt, PDF, etc) (look also at the task manager/system
monitor/Activity monitor)

4 In a new tab - open another local file of your choice (PNG,
HTML, WebM, .txt, PDF, etc) (look also at the task
manager/system monitor/Activity monitor)

5 In a new tab - open another local file of your choice (PNG,
HTML, WebM, .txt, PDF, etc) (look also at the task
manager/system monitor/Activity monitor)

6 Close all the local files opened in steps 3, 4 and 5 (look also
at the task manager/system monitor/Activity monitor)

7 In a new tab - open a local file from where you can open
another local file (Testl HTML local file)

8 Click on the "Click here" link (look also at the task
manager/system monitor/Activity monitor)

9 Go to about:preferences -> General -> uncheck the "Open
new windows in a new tab instead" option

10 Go back to Testl HTML local file opened in step 7

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Expected Result

Firefox is opened

A new Private Window is opened

The local file is properly opened

A new file content process is opened in the task manager
(the PID number from task manager is the same as the
number that is displayed when hovering the mouse over the
containing tab)

The local file is properly opened

Nightly - A new file content process is opened in the task
manager (the PID number from task manager is the same as
the number that is displayed when hovering the mouse over
the containing tab)

The local file is properly opened
No other file content process is opened. The local file has the
same process as one of the 2 previous opened processes.

The 2 content processes opened for the local files are closed

Testl local HTML file is properly opened

A new file content process is opened in the task manager
(the PID number from task manager is the same as the
number that is displayed when hovering the mouse over the
containing tab)

Test2 local HTML file is properly opened in a new tab
Nightly - the local file might be opened using the same
content process as in step 7 or a new one (Note: not more
than 2 content processes are allocated for local files)

Preference is unchecked
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11 Click on the "Click here" link (look also at the task

Test2 local file is opened in a new window.
manager/system monitor/Activity monitor)

The local file might be opened using the same content
process as in step 7 or a new one (Note: not more than 2
content processes are allocated for local files)
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C30642: Open a local file on the default settings

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate References
None None

1. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

2. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps
Step

1 Launch Firefox with a new profile (dom.ipc.processCount.file
preference is set to 1)

2 Open a local file by going to File Menu, click on Open File ->

select any local file -> Open (look also at the task
manager/system monitor/Activity monitor)

3 In a new tab, open a local file by hitting the Ctrl+0 keys
(CMD+0 on Mac OS X), selecting the file and choosing the

Open button

4 Open a new local file by dragging and dropping it in the tabs

bar

5 Open a new tab and load the local HTML file named Test1

(created at a previous test case)

6 Click on the Click here link from step 5

7 In new tabs, open another 10 local files of your choice

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Expected Result

Firefox is opened (only one process content is allocated for
the local files)

The Open File window is opened.

The selection of a local file is allowed.

The local File is properly opened

A new file content process is opened in the task
manager/system monitor/Activity monitor.

The Open file is opened
The local file is properly selected and opened
The file content process is the same as in step 2

The local file is properly opened in a new tab after being
dragged and dropped in the tabs bar
The file content process is the same as in steps 2 and 3

Testl local file is properly opened
The file content process is the same as in step 2, 3 and 4

Test2 local file is properly opened
The file content process is the same as in step 2, 3, 4 and 5

All the local files are opened
All the local files use the same local process as in steps:
2,3,4,5,6
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C20017: Open multiple local files in the same Firefox session

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions
1. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.
2. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps

Step

Launch Firefox with a NEW profile (check the value of the
preference "dom.ipc.processCount" in about:config)

In the 2 already opened tabs, navigate to 2 websites of your
choice (look also at the task manager/system monitor/Activity
monitor)

In new tabs, navigate to 2 websites of your choice

Navigate to about:config and add an integer preference
called "dom.ipc.processCount.file" and set the value to 6

In a new tab, open a local file of your choice (PNG, HTML,
WebM, .txt, PDF, etc) (look also at the task manager/system
monitor/Activity monitor)

In a new tab, open another local file of your choice (PNG,
HTML, WebM, .txt, PDF, etc) (look also at the task
manager/system monitor/Activity monitor)

In a new tab, open another local file of your choice (PNG,
HTML, WebM, .txt, PDF, etc) (look also at the task
manager/system monitor/Activity monitor)

Open 3 more local files of your choice (after each opened
local file check the task manager/system monitor/Activity
monitor)

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Expected Result

Firefox is launched
The value of the preference "dom.ipc.processCount” tells you
how many content processes are allocated for the websites.

The navigation is allowed
The content processes remain as before for each website

The navigation is allowed

2 new content processes are opened

Note: in step 1, the value of the preference
"dom.ipc.processCount" is set to 4 by default. The number of
opened content processes is influenced by the value of the
preference "dom.ipc.processCount”.

Preference is added

The value of the preference "dom.ipc.processCount.file" tells
you how many content processes are allocated for the local
files.

The local file is properly opened

A new file content process is opened in the task manager
(the PID number from task manager is the same as the
number that is displayed when hovering the mouse over the
containing tab)

The local file is properly opened

Nightly - A new file content process is opened in the task
manager (the PID number from task manager is the same as
the number that is displayed when hovering the mouse over
the containing tab)

The local file is properly opened

Nightly - A new file content process is opened in the task
manager (the PID number from task manager is the same as
the number that is displayed when hovering the mouse over
the containing tab)

The local files are opened.
Each local file is opened in a new content process
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9 Open 3 more local files of your choice (after each opened

local file check the task manager/system monitor/Activity
monitor)

The local files are opened
No other file content process is opened. Each local file is
randomly opened in one of the previous content processes

(where local files were opened, not the websites from step
2).
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C21685: [Windows only] Open local files when toggling preference
"browser.tabs.remote.separateFileUriProcess"

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).
2. Install the Process Explorer tool: https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx

Steps
Step Expected Result
1 Launch Firefox with a new profile (write down the content Firefox is opened
processes of the 2 tabs)
2 In the first tab - navigate to a website of your choice Navigation is allowed
The content process remains the same as in step 1

3 In the second tab - open a local file The local file is opened
A new file content process replaces one of the content
processes from step 1 (the ID of the process is different
when compared with the ID of the process from step 1)

4 Open the Process Explorer tool, look for the processes from There are differences between the web content process and
steps 2 and 3 -> right click on each -> Properties and the local content process - for example, on the web content
compare the 2 Groups IDs. process, you will see some Restricted flags.

5 Navigate to about:config and set preference Changing the preference's value is allowed
"browser.tabs.remote.separateFileUriProcess" to false

6 Restart Firefox (Shift+F2/Cmd+F2) Firefox is restarted

7 Open a new website and a new local file and using the There are no differences between the 2 properties tabs
Process Explorer tool compare the Properties tabs

8 Navigate to about:config again and set the preference Changing the preference's value is allowed
"browser.tabs.remote.separateFileUriProcess" back to true

9 Open another website and another local file and using the There are differences between the web content process and

Process Explorer tool compare the Properties tabs the local content process - for example, on the web content
process, you will see some Restricted flags.
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C26101: [Ubuntu/Mac OS X only]Open local files when toggling preference

"browser.tabs.remote.separateFileUriProcess"

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate
None None

References

1. In about:config, look at the value of the preference dom.ipc.processCount - this value tells you how many processes are opened

for the websites.

2. In about:config, look at the value of the preference dom.ipc.processCount.file - this value tells you how many processes are

opened for the local files

Steps
Step
1 Launch Firefox
2 In new tabs, open 7 websites of your choice (look also at

System monitor/Activity monitor)

3 In new tabs, open 7 local files of your choice (look also at
System monitor/Activity monitor)

4 Navigate to about:config and set preference
"browser.tabs.remote.separateFileUriProcess" to false

5 Close Firefox
6 Open Firefox
7 In new tabs, open 7 websites of your choice (look also at

System monitor/Activity monitor)

8 In new tabs, open 7 local files of your choice (look also at
System monitor/Activity monitor)

9 Navigate to about:config and set preference
"browser.tabs.remote.separateFileUriProcess" to true

10  Restart Firefox

11 Repeat steps 2 and 3

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Expected Result

Firefox is opened

All the websites are properly opened

All the websites share one or multiple content processes (the
number of the content processes opened is given by the
value of preference dom.ipc.processCount )

All the local files are properly opened

All the local files share one or multiple content processes
(the number of the content processes opened is given by the
value of preference dom.ipc.processCount.file). For e.g, if
the value is one, only one content processes is opened for all
the local files

Changing the preference's value is allowed

Firefox is closed

Firefox is opened

All the websites are properly opened

All the websites share one or multiple content processes (the
number of the content processes opened is given by the
value of preference dom.ipc.processCount)

All the local files are properly opened
No other new processes are opened - the processes from the
previous step are used

Changing the preference's value is allowed

The expected results are the same as in steps 2 and 3
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C29121: Submit form to http(s) URL using POST method from a local HTML page

Type Priority
Other Medium
Automatable

No

Preconditions

1. To be run after Bug 1351358 is fixed.

Estimate References
None None

2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.
3. Create a local HTML file that contains:

<IDOCTYPE html>

<html>

<head>
<title>PostFormTest< /title>
<meta charset="UTF-8">
</head>

<body>

<form method="post" action=" http://software.hixie.ch/utilities/cgi/test-tools/echo" enctype="multipart/form-data">

<input type="file" nhame="test">

<button type="submit">Submit</button>
</form>

</body>

</html>

Steps
Step

1 Launch Firefox with a new profile

2 Open a new tab and load the PostFormTest local HTML page

(check also the content process ID)

3 Click on the Browse button, select a local file and click
Submit

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Expected Result

Firefox is opened.

The local file is properly opened
A new local content process is opened

You are taken to http://software.hixie.ch/utilities/cgi/test-
tools/echo

The content process remains the same as in step 2.

Under the Content section, on the right side, you will see the
name of the uploaded file and it should look something like:

Content

00000000 2d 2d 2d 2d 2d 2d 2d 2d 2d 2d 2d 2d 2d 2d 2d

00000020 39 39 31 3536 37 39 33 31 35 39 36 0d 0a 43
6f |991567931596..Co|

00000030 6e 74 65 6e 74 2d 44 69 73 70 6f 73 69 74 69
6f |ntent-Dispositio|

00000040 6e 3a 20 66 6f 72 6d 2d 64 61 74 61 3b 20 6e
61 |n: form-data; na|

00000050 6d 65 3d 22 74 65 73 74 22 3b 20 66 69 6¢C 65
6e |me="test"; filen|

00000060 61 6d 65 3d 22 4d 6f 7a 69 6¢ 6¢€ 61 2d 6C 6f 67
|ame="Mozilla-log |

00000070 6f 2e 6a 70 67 22 0d Oa 43 6f 6e 74 65 6e 74 2d
|o.jpg"..Content-|

00000080 54 79 70 65 3a 20 69 6d 61 67 65 2f 6a 70 65
67 |Type: image/jpeg|
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00000090 0d Oa Od Oa ff d8 ff €0 00 10 4a 46 49 46 00 01
I IFIF.|

000000b0
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C39786: Open http(s) content linked from file:// URI

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

2. Create a local HTML file that contains a http page and and htpps page linked to the local file. You can take the following local html
as an example:

<IDOCTYPE html>

<html>
<title>HTTP(S)Test</title>
<body>
<a href="file:///C:/Users/svuser/Desktop/local/about.html|" target="_blank"> Local File </a>
<br>
<a href="https://www.youtube.com/watch?v=0IH1RCs96JA" target="_blank"> HTTPS page </a>
<br>
<a href="http://edition.cnn.com/" target="_blank"> HTTP page </a>
</body>
</html>

Steps

Step Expected Result
1 Launch Firefox with a new profile Firefox is opened.

2 Open a new tab and load the local HTML named HTTP(S) Test The local file is properly opened

A new local content process is opened

3 In the local HTTP(S) Test, LEFT click on the Local File link The local file is properly opened in a new tab
The local file is opened in the same content process as in

step 2

In the local HTTP(S) Test, LEFT click on the HTTP page

In the local HTTP(S) Test, LEFT click on the HTTPS page

In the local HTTP(S) Test, RIGHT click on the HTTP page and
from the context menu select Open Link in a New Tab

In the local HTTP(S) Test, RIGHT click on the HTTPS page
and from the context menu select Open Link in a New Tab

In the local HTTP(S) test, LEFT click on the HTTP page, then
write a different address in the URL bar and hit enter

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

HTTP page is properly opened in a new tab
The page is opened in the same content process as in step 2

HTTPS page is properly opened in a new tab
The page is opened in the same content process as in step 2

HTTP page is properly opened in a new tab
The page is opened in a different process than the local one
(from steps 2,3,4,5)

HTTPS page is properly opened in a new tab
The page is opened in a different process than the local one
(from steps 2,3,4,5)

The HTTP page is opened in the same content process as the
local file from step 2

A new page is opened in the same tab, but the content
process is different than the process from step 2
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In the local HTTP(S) test, LEFT click on the HTTPS page, then The HTTPS page is opened in the same content process as
write a different address in the URL bar and hit enter the local file from step 2

A new page is opened in the same tab, but the content
process is different than the process from step 2
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2. Navigation

C20011: Local files and http sites

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions
1. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.
2. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps

Step

Launch Firefox

Open any local file of your choice (check also the task
manager/system monitor/Activity monitor)

In the same tab, open any website of your choice (check also
the task manager/system monitor/Activity monitor)

Go back to the local file from step 2 by clicking on the back
button (check also the task manager/system monitor/Activity
monitor)

Click on the Forward button (check also the task
manager/system monitor/Activity monitor)

In a new tab, navigate to 2 different local files (check also
the task manager/system monitor/Activity monitor)

In the same tab as in step 6, navigate to 2 different websites
(check also the task manager/system monitor/Activity
monitor)

Navigate through the tab history by clicking on the
back/forward button a couple of times (check also the task
manager/system monitor/Activity monitor)
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Expected Result

Firefox is opened

The local file is opened
A new file content process is opened

The website is opened
The file content process is replaced by a new content
process (is changed)

You are taken to the local file from step 2
The content process is changed again

You are taken to the website opened in step 3
The content process is changed again

The local files are properly displayed
The file content process is the same for both the local files

Navigation is allowed for both the websites

After navigating to the first website the content process is
changed

The content process remains the same after navigating to the
second website

Navigation through the history is done respecting the initial
order

The content process change each time when the transition
between a local file and a website is done
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C20012: Local files and about pages

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate References
None None

1. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

2. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).ok

Steps
Step

1 Open Firefox (check also the task manager/system
monitor/Activity monitor)

2 In a new tab, navigate to about:support (check also the task
manager/system monitor/Activity monitor)

3 In the same tab, open a local file of your choice (check also
the task manager/system monitor/Activity monitor)

4 In the same tab, open another local file

5 In the same tab, navigate to about:preferences

6 Navigate through the tab's history by clicking on the
back/forward buttons
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Expected Result

Firefox is opened

Navigation is allowed
The tab has no content process ID on hover
No other content process is opened

The local file is opened
A new file content process is opened

The local file is opened
The content process remains the same

Navigation is allowed
The tab has no content process ID on hover
The process content from step 3 and 4 is closed

Navigation back and forward is allowed

When a local file is first in focus a new content process is
opened, same process is displayed when navigating right to
the next local file

When an about: page is in focus, the content process that
was opened for the local file is closed
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C20013: Local files opened in View Source Tabs

Type
Other

Priority
Medium

Automatable

No

Preconditions

Estimate
None

References
None

1. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

2. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

3. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2

Steps

Step

Launch Firefox

In a new tab, open an HTML local file

Open the View Page Source (Ctrl+U/Cmd+U)

In the same tab where the View Page Source was opened in
step 3, open another HTML local file

In a new tab, open a website of your choice

Open the View Page Source

In the same tab where the View page Source was opened,

open an HTML local file
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Expected Result

Firefox is opened

The HTML local file is opened
A new file content process is opened

A new tab with the view page source is opened
The content process is the same as in step 2

The local file is opened
The content process is the same as in step 2

The website is opened
A new content process is opened

A new tab with the view page source is opened
The content process is the same as in step 5

The local file is opened
The content process from step 5 is changed with another
(either the ID from step 2 or a new one)
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C20981: Responsive Design Mode and local files

Type Priority
Other Medium
Automatable

No

Preconditions

1. Open Firefox with a new profile.

Estimate
None None

Separate content process for file:// URLs [EngQA] - TestRail

References

2. Check the value of the "dom.ipc.processCount.file"preference is about:config.
3. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

4. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps
Step

1 Launch Firefox

2 Navigate to a website of your choice (look also at the task
manager/system monitor/Activity monitor)

3 Enter into Responsive Design Mode (Open Menu ->

Developers -> Responsive Design Mode, and check also the

ID of the content process)

4 Hit the keys Ctrl+0/Cmd+0 -> select a local file (look also at

the task manager/system monitor/Activity monitor)

5 Open a new tab and open another local file (look also at the

task manager/system monitor/Activity monitor)

6 Enter Responsive Design Mode
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Expected Result

Firefox is opened

Navigation is allowed.

The website is entered in Responsive Design Mode
The ID of the content process is the same as in step 2

The local file is properly opened
The content processes changes to a new one

The local file is properly opened

On Nightly - a new content process is opened - but only if
the value of preference "dom.ipc.processCount.file" > than
1. If the preference "dom.ipc.processCount.file"=1 then no
new content process is opened (the content process is the
same as in step 4)

The local file is opened in RDM
The content process is the same as in step 5.
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C20008: Restore local files by using Ctrl+Shift+T/Cmd+Shift+T

Type Priority
Other Medium
Automatable

No

Preconditions

1. Open Firefox with a new profile

Estimate
None

References
None

2. Check the value of the "dom.ipc.processCount.file"preference is about:config.
3. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

4. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps
Step

1 Launch Firefox

2 Open 7 tabs and in each tab load local files of your choice
(look also at the task manager/system monitor/Activity
monitor)

3 Close all the tabs opened in step 2

4 Restore all the closed tabs by hitting the Ctrl+Shift+T on
Windows, Cmd+Shift+T on Mac O SX keys

5 In about:config set the preference dom.ipc.processCount.file
to 7

6 Close and Reopen Firefox

7 Open 7 tabs and in each tab load local files of your choice
(look also at the task manager/system monitor/Activity
monitor)

8 Close all the tabs opened in step 7

9 Restore all the closed tabs by hitting the Ctrl+Shift+T on
Windows, Cmd+Shift+T on Mac O SX keys
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Expected Result

Firefox is opened

All the local files are properly opened

The number of the content processes allocated for the local
files is dependent of the value of the preference
"dom.ipc.processCount.file". For e.g if
dom.ipc.processCount.file=1, all the local files will be opened
in the same content process

All the local files are closed
The content processes opened for the local files are also
closed

All the local files are opened
One or more content processes are opened for all the local
files (as many as in step 2)

The value of the preference is modified

Firefox is reopened

All the local files are properly opened
7 content processes are allocated for the opened local files.

All the local files are closed
The 7 content processes opened for the local files are also
closed

All the local files are opened
Seven content processes are opened for all the local files
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C20009: Session restore of local files by using the Restore Previous Session

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Open Firefox with a new profile
2. Check the value of the "dom.ipc.processCount.file"preference is about:config.

3. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

4. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps
Step Expected Result
1 Launch Firefox Firefox is properly opened
2 Open at least 5 local files of your choice All the local files are properly opened
The number of the content processes allocated for the local
files is dependent of the value of the preference
"dom.ipc.processCount.file". For e.g if
dom.ipc.processCount.file=1, all the local files will be opened
in the same content process
3 Close Firefox Firefox is closed
4 Open Firefox again Firefox is properly opened
5 In the lower right side - click on the Restore Previous Session If hovering the mouse over the tabs, only the tab that is in
button focus has the process ID displayed (the content is not loaded
for the other tabs)
6 Focus each tab one by one The content process is displayed on hover for all the tab
One or more content processes are opened for all the local
files (as many as in step 2)
7 Go to about:config and set preference The value of the preference is changed
"dom.ipc.processCount.file" to 3
8 Close and reopen Firefox Firefox is reopened
9 Repeat step 2-6 Same results with the exception that this time - 3 content

processes are allocated for the local files.
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C20010: Session restore of local files after a Firefox crash

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1.0pen Firefox with a new profile

2. Check the value of the "dom.ipc.processCount.file"preference is about:config.

3. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

4. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps
Step Expected Result
1 Launch Firefox Firefox is opened
2 Install the crash me now add-on and place it on the tabs bar Add-on is installed. (The black little bomb icon is also
(Open menu -> Customize -> place Crash add-on the tabs properly placed in the tabs bar)
bar)
https://addons.mozilla.org/en-US/firefox/addon/crash-me-
now-simple/?src=ss
3 Open at least 5 new tabs and in each load any local file of All the local files are properly opened
your choice The number of the content processes allocated for the local
files is dependent of the value of the preference
"dom.ipc.processCount.file". For e.g if
dom.ipc.processCount.file=1, all the local files will be opened
in the same content process
4 Click on Crash your browser icon in the tabs bar and chose Firefox crashes and the Mozilla Crash Reporter dialog is
to Restart Firefox (don't forget to write "this is a test" as a displayed
comment in the crash dialog). Firefox is Restored (if it was crashed more than once the
Restore button will be also shown, clicking it - restores all
the previous tabs)
On hover, only the tab that is in focus has the Content
process displayed.
5 Focus each tab one by one The content processes are displayed for all the tabs on

hover.
One or more content processes are opened for all the local
files (as many as in step 3)
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C34507: Session restore of local files after a Firefox content crash

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1.0pen Firefox with a new profile

2. In about:config set the value of the "dom.ipc.processCount.file"preference to 2.

3. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

4. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps

Step Expected Result

Launch Firefox

Install the crash me now add-on and place it on the Open
menu panel (Open menu -> Customize and drag the "Crash
Content process" over the Open menu panel area
https://addons.mozilla.org/en-US/firefox/addon/crash-me-
now-simple/?src=ss

Open at least 5 new tabs and in each load any local file of
your choice

Place yourself in any tab of a local file, hover your mouse

Firefox is opened

Add-on is installed. (The Crash Content process icon is
placed in the Open menu panel)

All the local files are properly opened
2 content processes are allocated for the local files

One or more local files share the same content process.

over the tab to see the PID of the content process and check
how many local files share the same content process

The content of that local file crashes

If you hover the mouse of the tabs of the local files that
shared the same content process you will notice that there is
no process ID between the brackets

The content process of the local file from step 4 is closed in
the task manager/System Monitor /Activity Monitor.

The other local content process opened in step 2 remains
opened.

5 Click on Crash Content process icon in the Open menu panel

6 Chose to Restore This Tab The tab with the local file is properly restored and a new

content process is opened for it

Each opened local file has an allocated process content ID
available between the brackets

7 Reload all the tabs and hover your mouse over all the local
files tabs
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C26278: Reload local files

Type Priority
Other Medium
Automatable

No

Preconditions

Estimate References
None None

1. Open Firefox, navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the

processes ID.

3. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

Steps
Step

1 Launch Firefox

2 In new tabs, open 2 websites of your choice (look also at the
task manager/system monitor/Activity monitor)

3 Open at least 5 local files of your choice (look also at the task

manager/system monitor/Activity monitor)

4 Right click on any tab and select Reload All Tabs (look also at

the task manager/system monitor/Activity monitor)
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Expected Result

Firefox is opened

The websites are properly opened
2 content processes should be opened for the websites

The local files are properly opened
Two content processes are opened for all the local files

All the tabs are properly reloaded
The ids of the content processes are not changed (not before
nor after the reload)
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4. Accessibility

C26103: Local files and screen readers

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. In about:config, set the preference dom.ipc.processCount.file = 3

2. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

3. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc).

4. Download and install a screen reader tool: Windows: http://www.nvaccess.org/download Ubuntu : Universal Access (already
installed) -> All settings -> Screen reader -> set it to ON Mac OS X: Use "Voice Over" which is already installed. System
Preferences> Accesibility> Voice Over> "Enable Voice Over"

Steps

Step

Open the screen reader

Launch Firefox

In new tabs, open 3 websites of your choice (look also at the
task manager/system monitor/Activity monitor)

In new tabs, open 3 local files of your choice (look also at the
task manager/system monitor/Activity monitor)

In new tabs, open 2 more local files of your choice (unrelated
local files)
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Expected Result

Firefox is opened

The websites are properly opened.

The local files are properly opened in 3 new local content
processes
The screen reader is not influencing in any way

The local files are properly opened
No new content process is opened
The screen reader is not influencing in any way
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5. Other tests

C22416: Add-ons - most popular, save as

Type Priority Estimate References
Other Medium None None
Automatable
No
Preconditions
1.Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc.).
2. Create a local HTML file (name is Test4) that contains:
<body>
<a onclick="DownloadText('foo.txt', ['1','2",'3']);">click-me</a>
<script>
function DownloadText(filename, textArr, mimetype="text/plain') {
var blob = new Blob(textArr, {type: mimetype});
var url = URL.createObjectURL(blob);
var link = document.createElement('a');
link.href = url;
link.download = filename;
document.body.appendChild(1link);
link.click();
document.body.removeChild(1link);
}
</script>
</body>
3. Save a .xpi file from: https://ftp.mozilla.org/pub/firefox/releases/52.0b8/win32/xpi/
4.Navigate to about:config and set the preference "dom.ipc.processCount.file" = 2
Steps
Step Expected Result
1 Launch Firefox Firefox is opened
2 Install the first 10 most popular extensions from: All the extensions are installed
https://addons.mozilla.org/en-us/firefox/extensions/?
sort=users
3 Open the local file named Test4 (look at the Process ID) The local file is opened
A new content process is opened for the local file
4 Click on click-me and select Save File The file is downloaded

5 Open the Download panel, drag the downloaded file and drop A new local file is opened

it onto the Tabs bar On Nightly - a new content process is opened
6 Open 6 more local files (by drag and drop, File-> Open File, All the local files are properly opened
Ctrl+0 key shortcut) On Nightly - the same 2 processes opened in steps 3 and 5

are used for all the local files

7 Close all the tabs opened in steps 5 and 6.
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All the local files are properly closed.
Only one file content process remains opened for the local
file opened in step 3.
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8 Open a new tab and load a website of your choice, drag the The content of the page remains the same
.xpi file and drop it over the tab The panel with the install request of the .xpi file is displayed
The content process of the tab after the install is done is the
same as before starting the installation of the add-on.

9 Open a local file, drag the .xpi file and drop it over the tab The content of the page remains the same
The panel with the install request of the .xpi file is displayed
The content process remains the same after the install as it
was before the add-on install.

https://testrail .stage.mozaws.net/index.php?/suites/plot/576&format=details 33/37



6/2/2017 Separate content process for file:// URLs [EngQA] - TestRail
C22417: Open a local file from History and Bookmarks

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Open Firefox with a new profile
2. Check the value of the "dom.ipc.processCount.file"preference is about:config.
3. Have several local files saved on your PC (PNG, HTML, WebM, .txt, PDF, etc.).

Steps
Step Expected Result
1 Launch Firefox Firefox is opened
2 Open 7 local files of your choice The local files are opened
The number of the content processes allocated for the local
files is dependent on the value of the preference
"dom.ipc.processCount.file". For e.g if
dom.ipc.processCount.file=1, all the local files will be opened
in the same content process
3 Close Firefox Firefox is closed
4 Open Firefox Firefox is opened
5 In the Tabs bar -> click on Open Menu -> click on History -> All the local files from step 2 are opened properly
Show All History -> Today -> Open All in Tabs The number of the content processes allocated for the local
files is dependent on the value of the preference
"dom.ipc.processCount.file". For e.g if
dom.ipc.processCount.file=1, all the local files will be opened
in the same content process
6 Right click on any Tab -> select Bookmark all Tabs -> name All the tabs that are opened in step 5 are bookmarked
the folder -> add Bookmarks
7 Close Firefox Firefox is closed
8 Open Firefox again Firefox is opened
9 Open the Bookmarks sidebar -> right click on the folder All the tabs are properly opened (including the local files)

saved in step 7 -> Open all in Tabs The number of the content processes allocated for the local
files is dependent on the value of the preference
"dom.ipc.processCount.file". For e.g if
dom.ipc.processCount.file=1, all the local files will be opened
in the same content process
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C22418: telemetry

Type Priority Estimate References
Other Medium None None
Automatable

No

Preconditions

1. Open the Task manager (Windows - Go to the Details tab)/System Monitor (Ubuntu)/Activity Monitor (Mac OS X) and look at the
processes ID.

2. Create the following local HTML page named Telemetry Test:

<IDOCTYPE html>

<html>

<title>Telemetry Test</title>

<body>

<iframe height="500px" width="100%" src="https://googlechrome.github.io/samples/service-worker/registration/index.html">
</iframe>

</body>

</html>

Steps

Step Expected Result

Launch Firefox

Navigate to about:telemetry -> click on Histograms -> click
on the dropdown near "parent" and select "content" -> look
for the FILE_EMBEDDED_SERVICEWORKERS parameter

Open a new tab and load the local HTML page named
Telemetry Test (look also at the task manager/system
monitor/Activity monitor)

Open the Web Console by going to: Open menu -> Developer
-> Web Console

Go back to the Telemetry Data from step 2, refresh the page,
click on Histograms -> click on the dropdown near "parent"
and select "content" -> look for the
FILE_EMBEDDED_SERVICEWORKERS parameter

Open a new tab and load the local HTML page named
Telemetry Test again (look also at the task manager/system
monitor/Activity monitor)

Go back to the Telemetry Data from step 2, refresh the page,
click on Histograms -> click on the dropdown near "parent"
and select "content" -> look for the

FILE_ EMBEDDED_SERVICEWORKERS parameter

https://testrail.stage.mozaws.net/index.php?/suites/plot/576&format=details

Firefox is opened

The Telemetry data page is opened
The FILE_EMBEDDED_SERVICEWORKERS parameter is not
found

The local page is properly opened - an iframe with the
Service Worker Sample: Basic Registration
A new content process is opened

The following message is displayed in the web console:
"ServiceWorker registered by document embedded in a
file:/// URL. This may result in unexpected behavior."

The Telemetry data page is opened
The FILE_EMBEDDED_SERVICEWORKERS parameter is found
having 1 sample

The local page is properly opened - an iframe with the
Service Worker Sample: Basic Registration

The parameter FILE_ EMBEDDED_SERVICEWORKERS
parameter is found, 2 samples are now displayed
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C26102: Local files while el10s is off

Type Priority

Other Medium

Automatable

No

Steps
Step

1 Launch Firefox

2 Go to about:preferences -> General -> uncheck "Enable
multi-process Nightly" -> select to restart when prompted

3 Open several websites of your choice (check also the task

manager/system monitor/Activity monitor)

4 Open several different local files of your choice (check also
the task manager/system monitor/Activity monitor)

5 In a new tab, open a website of your choice, then a local file,
another website, and another local file (check also the task
manager/system monitor/Activity monitor)

6 Click on the Back and Forward buttons for a couple of times
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Estimate
None

Separate content process for file:// URLs [EngQA] - TestRail

References
None

Expected Result

Firefox is opened

Firefox is restarted and e10s is disabled

All the websites are properly opened and use the same
content process

All the local files are using the same content process as in
step 3

Web sites and local files are properly opened in the same tab

No other content process is opened

Navigating to the tab history is properly done
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6. Regressions tests
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